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Chapter 1. Introduction to Fuse HQ

This chapter introduces basic concepts and terminology and helps the administrator get ready to set up and
monitor a Fuse HQ system.

L= T 12
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Chapter 1. Introduction to Fuse HQ

Overview

What is Fuse HQ?

Fuse HQ architecture

Fuse HQ terminology

12

Fuse HQ is a set of tools that let you monitor a wide range of activity on any
group of machines that you can access via HTTP. It is highly customizable,
letting you determine what activity you want to see, what conditions cause
alerts and what actions are taken in response, and who has access to the
tools.

This book focuses on using Fuse HQ to monitor other components of the ,
Fuse Message Broker and Fuse ESB. As installed, Fuse HQ can automatically
detect and monitor these and many other processes, including, for example,
Web servers, database servers, and CPU activity. In addition, you can develop
plugins that enable monitoring of other processes that are not automatically
supported.

A Fuse HQ system comprises one or more agents, a server, and a database.

* Agent — An agent runs on each machine that you want to monitor. Each
agent discovers resources and monitors activity on its host machine, and
sends information about the resources and activity to the server. In the
context of a system, typically a Fuse HQ agent runs on each machine that
hosts a Fuse Message Broker.

* Server — The server runs on a single host. The server gathers information
from the agents and manages the database. It includes the browser-based
user interface component, called the HQ Portal, which displays metrics
and alerts and provides the necessary tools for configuration, administration,
and reporting. (A command line interface, not described in this book, is
also available.)

Database —The database stores all HQ-related data, including system
inventory information, data gathered by the agents, and configuration data
governing behavior and access. You have the option of using a built-in
PostgreSQL database installed with Fuse HQ, or a standalone database
(Oracle, PostgreSQL, or MySQL). In this guide, it is assumed that you are
using the built-in database, which requires no setup or configuration.

The components of your system that Fuse HQ can monitor are called
resources. From the resources available on your system, you choose the
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Overview

specific ones that you want to monitor. This set of resources is your inventory.
The inventory comprises both basic resources and composite resources.

Basic resources include platforms, servers, and services.

* Platform — A platform is typically a computer (a combination of a machine
and an operating system). It can also be a network device or a storage
device. Platforms host servers.

* Server — A server is a process, running on a platform, that provides
services. Each server provides multiple services. In the , the Fuse Message
Broker and the Fuse ESB container are servers.

* Service — A service is a server component that provides a specific, discrete
function. In the , services include the connectors, topics, and queues running
on a Fuse Message Broker, and the various services deployed in a Fuse
ESB container.

You combine selected basic resources, according to your own criteria, to
define and add to your inventory two types of composite resources: groups
and applications.

* Group — A group can consist of any combination of platforms, servers,
and services. Groups can be mixed or compatible. If a group is compatible,
meaning that its member resources share the same metrics and control
actions, you can monitor and act on all of those resources as a single entity.
Groups have an important function in setting permissions, as the groups
assigned to a user's role determine the resources that are visible to that
user.

* Application — Any set of services can be aggregated as an application, as

appropriate. This allows you to focus logically on the actual work that your
deployed services perform.
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Chapter 1. Introduction to Fuse HQ

Fuse HQ Capabilities

Discovering, monitoring, and
controlling resources

Managing problems and alerts

Tracking events

Managing users and permissions

14

The Fuse HQ agent automatically discovers your platforms and resources (as
well as many other types of resources) and sends information about them to
the server. The Fuse HQ server lets you monitor their state and activity from
any Web browser. You use the Fuse HQ Dashboard (the Ul's home page) and
related views to select the resources you are interested in and inspect details
about their availability and levels of activity.

In addition to monitoring the resources in your inventory, you can perform
various control actions on some of the servers and services. For example,
with Fuse Message Broker, you can start and stop a broker or send a text
message to a queue or topic. Available control actions depend on the specific
type of server or service.

Fuse HQ can show you at a glance where problems are occurring or are likely
to occur. Resources that are unavailable are automatically highlighted. You
can define custom alert conditions based on any metric values and events
that the selected resources generate. For example, you can choose to be
notified when the number of messages on a given queue exceeds a specific
value. As another example, you might define an alert to be raised whenever
a resource logs a warning message.

You can use Fuse HQ to view entries in the log files of any of the platforms
and servers in your inventory. Configuration options let you specify precisely
which events you want Fuse HQ to capture for each resource. Using the
event-tracking feature is far more convenient than opening the individual files,
which may be scattered across the network and typically are cluttered with
messages that are not of interest. You can also define alerts to be triggered
by logged events.

Each user of the Fuse HQ Portal has a login ID and password. Two factors
determine what a given user can see and do when logged in: the user's role,
and the resource groups that are assigned to that role. The role consists of a
set of permissions that allow specific actions (such as viewing, modifying, or
creating) on each different resource type. The groups delimit the resources
to which the user has access.

As installed, Fuse HQ provides two predefined roles: A Guest role allows
view-only access to all resource types, and a Super User role allows
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Fuse HQ Capabilities

unrestricted access to all resources and functions. The Super User role is
exceptional in that no group assignment is required in order to enable access
to resources.

The first person to log in to Fuse HQ uses the administrator ID and password
chosen during installation. This account belongs to the Super User role,
enabling the administrator to create custom roles and assign users and groups
to them. A user can have multiple roles.

Customizing information display The Fuse HQ Dashboard, shown in Fuse HQ Dashboard, is the starting point
for each session.

Figure 1.1. Fuse HQ Dashboard

Recent Alerts: (There have been no alerts in the last 2 hours.)

FU S em H Q Resources Administration |

‘seiecla Dashboard haadmin v |

No resources to display
[ Resource tame | [ Patiorms |8

SavedCharis e Resourse u aiiaiiity Alerts

No saved charts to display; to add charts to dashboard press *Save Chart to Type
Dashboard" in the Tooks Menu of meiric chart view. No resources to display, please ciick the ‘G icon above to add resourses to portet
Updated: 558 Pl

Resource Name Time

nbwihibolton.emes.progress.com 1 hour ago [ \Dafe) Dime o et Mo Dezourpe ame e ficd L=

No recent alerts to display

Availabilit 1a 1
(Avataiy Summary 3 | Updated: 5:56 PIt
Resource Type Availability

No resources todisplay, pease cick the &8 icon sbove to add resources o portet. (& ConwolActions & |
Add content to this column: RS SO

Select Portiet 3@ No resources to display

Quick Control Frequency

Ho resources to display

Resource Hame Availability Alerts OOB Last

No resources to display, please ciick the ‘5 icon above to add resourses to portiet
Updated: 558 Pl

Add content to this column:

-

The Dashboard is flexible with respect to the information it shows. Each user
has access to two or more versions of the Dashboard: a personal version, and
the version associated with each of the user's roles. You can customize your
own personal Dashboard. You can adjust the layout of the various windows
(called portlets), choose the resources and alerts that you want to see, and
control various other display settings.
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Chapter 1. Introduction to Fuse HQ

The administrator determines the layout and content of the role-based
Dashboards. Users cannot modify a role-based Dashboard unless they belong
to a role that has explicit permission to modify roles.

16 Fuse HQ Getting Started With Fuse HQ Version 4.4



Setting up Fuse HQ

Setting up Fuse HQ

Installation

Startup

The discussions in this book assume that you have a working Fuse HQ system.
Specifically, make sure that:

* The Fuse HQ Server is installed on the appropriate host.

* At least one Fuse HQ Agent is installed. In an actual working environment,
there are likely to be agents running on multiple machines. However, an
agent running on the same host as the server (or on a separate machine)
is sufficient for the purpose of following the discussions here.

* Fuse Message Broker is running on at least one platform. The examples in
this book refer to Fuse Message Broker processes.

For installation procedures, see Installing Fuse HQ.

(@ Note

With Fuse HQ versions 4.0 and earlier, the server host and all agent
hosts must have static IP addresses to ensure stability.

Start Fuse Message Broker first, followed by the Fuse HQ Server and then
the Fuse HQ Agents. Starting Fuse Message Broker first is not a requirement,
but by doing so, you ensure that the HQ Agent will discover it and report it
to the HQ Server immediately.

To start the Fuse Message Broker:

If Fuse Message Broker is not already running, start it as follows:

1. Inacommand prompt or terminal window, change directory to the Fuse
Message Broker installation directory.

2. Change directory to the bin directory.

3. Type the following:
e Windows:

activemqg.bat

Fuse HQ Getting Started With Fuse HQ Version 4.4 17
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Chapter 1. Introduction to Fuse HQ

18

e UNIX or Linux:
./activemq
To start the Fuse HQ Server:

It is recommended that you install the Fuse HQ Server as a Windows service
or, on non-Windows platforms, include it in a startup script so that it runs
automatically each time the host is booted. See " Starting and Stopping the
Fuse HQ Server" in Installing Fuse HQ for details.

To start the Fuse HQ Agent:

You can install the Fuse HQ Agent as a Windows service or include it in a
startup script. However, the first time you run the Agent, you must start it
from a command shell and provide certain required information. Fuse HQ
stores this information so that subsequent sessions can start without user
intervention. See "Starting and Stopping the Fuse HQ Agent" in Installing
Fuse HQ for details.
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Opening the Fuse HQ Portal

Opening the Fuse HQ Portal

Accessing the login screen

Logging in to Fuse HQ

You can log in to Fuse HQ from any machine, provided firewall settings allow
HTTP communication between that machine and the Fuse HQ Server host.
In the address field of your Web browser, enter the following URL:

http://fuse-server-IP-address: 7080

2) Note

This URL assumes that the Fuse HQ Server was installed with the
default HTTP port, 7080. If not, substitute the correct port number.
You can find this and other installation settings in the file
hg-server-install.conf inthe install dir/data directory. The
HTTP port setting appears in the file as server.webapp.port.

The Fuse HQ login prompt appears, as shown in Fuse HQ login prompt.

Figure 1.2. Fuse HQ login prompt

Sign in to Fuse HQ
Please enter your username and passward to sign in.

Username | hgadmin |

Password | ....... |

To log in for the first time, enter the administrator ID and password (both
hgadmin by default) that were specified on installation of the Fuse HQ Server,
and click LocIN. The Fuse HQ Dashboard appears (Figure 1.1 on page 15).

Among the user administration tasks you perform, you should change the
as-installed administrator password before implementing Fuse HQ in a
production environment.
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Chapter 2. Discovering Resources

After you have the Fuse HQ Server installed and running, the next step is to start monitoring some applications.
This section explains how to initiate monitoring of applications by adding resources to the Fuse HQ Server's

resource inventory.

Adding @ Platform RESOUICE ... v.uit it e e ettt e teaeaaaas 22
AQAING RESOUICES ...ttt ettt e e et et et e e et ettt ettt ettt e e et et et et e e e e e e e aeeens 24
21

Fuse HQ Getting Started With Fuse HQ Version 4.4



Chapter 2. Discovering Resources

Adding a Platform Resource

Overview This section describes how to add a platform resource to Fuse HQ, where a
platform resource is identified with an Agent running on a particular host.

Prerequisites This tutorial assumes the following starting point:

* The Fuse HQ Server is already installed and running (for details, see
Installing Fuse HQ).

* You are logged on to the Fuse HQ console, currently viewing the dashboard
(for example, see "Opening the Fuse HQ Portal" on page 19 and
Figure 1.1 on page 15).

* The Fuse HQ Agent is not yet started on the host you want to monitor.

Steps To add a platform resource to the set of resources monitored by the Fuse HQ
Console, perform the following steps:

1. On the host that you want to monitor, start the Fuse HQ Agent (the platform
resource). See "Starting and Stopping the Fuse HQ Agent" in Installing
Fuse HQ for details of how to start the Agent.

2. The newly started agent is not visible right away on the console. The Agent
must complete an initial scan before it appears on the console. Wait a few
minutes (typically, 5 minutes, or more on some platforms), then click your
browser's refresh button to renew the dashboard screen. If there is no
change on the dashboard, wait a minute and try again. Keep refreshing
until a new platform resource appears in the Auto-Discovery portlet on the
dashboard, as follows:

22 Fuse HQ Getting Started With Fuse HQ Version 4.4
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Adding a Platform Resource

(There have been no alerts in the last 2 hours.)

Sign Qut Screencasts

Resources Administration

] Resource Name Status Changes

@ nbwfhfbolton.emea.progress.com - Microsoft Windows XP new NiA

\ AFUSE.\ i

nbw hfboltan HQ Tameat 6.0 _E‘_f’“f:;';‘fiu"z'"'Jhm new  NiA
web. deploye:

nbwfhfbolton HQ PostgreSQL E\Programs\FUSE\server-4.2.0.0-

82 fuselhadb dited

V] nbwfhfbolton HQ ...ent

E’\Programs\FUSE\agent-4.2.0.0-fuse new NiA

4.2.0.0-fuse
Availability
\FUSE\_\hg-gngine
nbwihibotion HQ Joss 4 L\ CarameiFUISEL. ing-engine new  N&
es to portlet. \serverdefault
m I CWINDOWS\Microsoft. NET B

‘Framework

Add to Inventory 1 Skip Checked Resources

3. To start monitoring the newly-discovered platform resource, click

Add to Invento )
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Chapter 2. Discovering Resources

Adding Resources

Overview This tutorial explains how to start monitoring a application on a particular
host, assuming that an Agent is already running on that host.

Prerequisites This tutorial assumes the following starting point:

* The Fuse HQ Server is already installed and running (for details, see
Installing Fuse HQ).

¢ You have already added a platform resource (Agent running on a host) for
the host where you intend to run the applications (see the preceding
tutorial).

* You are logged on to the Fuse HQ console, currently viewing the dashboard
(for example, see "Opening the Fuse HQ Portal" on page 19 and
Figure 1.1 on page 15).

Steps To add resources and view their properties in the Fuse HQ Console, perform
the following steps:

1. Start your application on the target host. In this example, we start a Fuse
Message Broker 5.3.0 broker.

2. From the dashboard, in the Recently Added portlet, identify the platform
resource corresponding to the host where you intend to run your application.
Click on the relevant hostname.

For example, the following illustration shows the clickable
nbwfhfbolton.emea.progress.com platform resource, highlighted by
a red rectangle:

24 Fuse HQ Getting Started With Fuse HQ Version 4.4
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Adding Resources

Fuse"HQ T

| Select a Dashboard hgadmin ~

|ResnurDe Name ‘ | Platforms. w |

Saved Charls
Neo saved charts to display: to add charts to dashboard press "Save Chart to

Dashboard" in the Tools Menu of metric chart view.

Recently Added " S
Resource Hame Time
|nbwfhﬂ:olton.emea‘ptogress.com | 1 hour ago

After clicking, you should see the Resources tab for the selected platform
resource.

3. In the Resources tab, locate the Map and Tools Menu drop-down menus,
as shown:

_MapE!l Tools Menu Ell

nbwfhfbolton .HET 2.0 nbwfhfbolton HQ Agent 4.2.0.0-fuse
E HET 20 server 2 HQ Agert sesver

nbwfhfbolton HO JBoss 4.x nbwfhfbolton HQ PostgreSaL 8.2 nbwfhfbolton HO Tomcat 6.0
f.l&r_mlim [nxg—mazm me:aanw

v/nhwﬂmroIlon.emea.prouress.com
Wini32 plagiorm

If you find that the Map graphic obscures your view of the Tools Menu
dron-down menu. close the map by clicking the small button next to Map,
MapEl  Tools Menu BI| which is highlighted here in red.

4. From the Tools Menu drop-down menu, select the New Auto-Discovery
menu option:

Tools Menu =

Configure Platform [

Clone Platform @

Delete Platform [

Hew Server ™

Hew Platform Service B

Hew Auto-Discovery [

Enable All Alerts On This Agent B
Disable All Alerts On This Agent

Add to Dashboard Favorites [
Add to Group @
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Chapter 2. Discovering Resources

5. Directly under the Quick Auto-Discovery Scan title, click the green Ok
button, as shown:

F Q Racent Alerts: (There have been no alerts in the last2hours)  \yelcome, HQ Sign (
use'H —

Dashboard Administration

nbwfhfbolton.emea.progress.com

Quick Auto-Discovery Scan
Click 'OK' to start an immediate system scan on all resource types. This will include a scan of the Windows registry and process table.
1f you also want to perform a filesystem scan or if you'd like to limit the resource types to be discovered, fill out the remainder of the form below.

“ww

The next screen that appears does not yet include the newly-started

resources.
2) Note

You could use the Extended Filesystem Scan Configuration section
to perform an additional filesystem scan and to restrict the server
types that are scanned. But be careful: if you let the filesystem
scan roam over your entire file system, the scan will take a very
long time to complete.

6. Click the Dashboard tab. Wait a few minutes (typically, 5 minutes, or more
on some platforms), then click your browser's refresh button to renew the
dashboard screen. If there is no change on the dashboard, wait a minute
and try again. Keep refreshing until a new platform resource appears in
the Auto-Discovery portlet on the dashboard, as follows:

(There have been no alerts in the last 2 hours.) Wielcome, HQ  Sign Out  Screencasts  Help

Resources Administration B search

Resource Hame Status Changes

g - Wi Wi .
@ nbwfhfbolton.emea.progress.com - Microsoft Windows modified SETYET set
i changed

nbw fhfbolton ActiveMQ  E:\ProgramsiFUSE\fuse-message-
Sx-fuse broker-5.3.0.0

Add to Inventory Skip Checked Resources

new N/A

Click Add to Inventory.
7. Under the Recently Added portlet, click the platform resource link for the

host where the application is running. This brings you to the Resources
tab for the chosen resource.
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Recently Added E o

Resource Name Time

nbwfhfbolton.emea.progress.com 13 minutes ago

8. Under the Monitor sub-tab of the Resources tab, you should now be able
to see your newly-added resource. For example, if you added a Fuse
Message Broker resource, you should see an ActiveMQ resource amongst
those listed, as shown:

b | anventory | Alert

Metric Display Range: «

RESOURCES

[ | Piatform Services Health

[ acru

D'_‘I FileServer Mount

D:l HetworkServer Interface

[ | peployed Servers Health
nbwfhfbolton .MET 2.0
nbwfhfbolton ActiveMQ 6.x-fuse

000 F
0404

b

nbwihfbolton HQ Agent 4.2.0.0-fuse
nbwfhfbolton HQ JBoss 4.x
nbwfhfbolton HQ Postgre SQL 8.2
nbwfhfbolton HQ Tomcat 6.0

LR RAR R ROTRY]

] | s
00000

Initially, the status of the newly-added resource is shown greyed-out. After
a few minutes (refresh the browser, if necessary), its status turns to green
and you can begin to monitor its properties.

For a brief overview of how to monitor a resource's properties, see "Console
Overview" on page 29.
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Chapter 3. Console Overview

This chapter describes the principal functional areas of Fuse HQ and explains how to find your way around the
user interface.

Getting Around in FUSE HQ ....eeenie e e e 30
The Dashboard and OTher VIBWS .........ieiii e e e e e aens 32
RESOUICE PagES ...viiiii it e e e e ettt e, 36
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Chapter 3. Console Overview

Getting Around in Fuse HQ

A look at some navigation controls

Hyperlinks

30

Navigation controls shows examples of some of the controls described in the
sections that follow.

Figure 3.1. Navigation controls

Sub-tab Tab

Hyperlink

Home

(There have been no alerts in the last 2 hours.)

Administration

Dashboard

Browse » nbwfhfbolton.emea.progress.com
Description: M Owner: HQ Adminigfrater (hgadmin) - Change...
Default Gatew: Secondary DNS 3477 Vendor : Micro
Vendor Ver: IP Address : Primary DNS :
CPU Speed : 2 0S5 Version RAM : 2048 MB
Architecture :

Map=| Tools Menu @

Inventory Alert Views
MEgtric Display Range: 4 Last & v Hours | % @ Advanced Settings
RESOURCES ™ INDICATORS ™,

D N i St Wi o W A Indicator Charts | Show Last 8§ Hours

[ocru ® o

DJ FileServer Mount <

S Cpu Usage

D_‘l NetworkServer Interfac @& o (Wina2) LOW: 12,

D Deployed Servers Health Avail

[ nbwbolton NET 2.0 e o

|:| nbwihfbolton ActiveMQ 5.x-fuse 8@ O

The Fuse HQ user interface is filled with the familiar blue text that indicates
clickable links. Almost anywhere that the name of a resource or other entity
appears, you can click it to jump to the logical place for focusing on that item.
In the case of a resource, that place is usually the resource's Current Health
screen (see "Monitor tab (Current Health screen)" on page 36).
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Menus

Navigating with the breadcrumb
path

Going home

Getting Around in Fuse HQ

These hyperlinks provide an intuitive way to find the information and tools
that you need, so use them freely. Your browser's Back command makes it
easy to return to your starting point.

Superimposed on the black strip at the top of the screen are the four main
tabs, Dashboard, Resources, Analyze, and Administration. Click these tabs
and their sub-entries to go to the views described in "The Dashboard and
Other Views" on page 32 .

In addition to this main menu, various small menus with self-explanatory
options appear as appropriate for different functional areas.

Immediately below the black strip at the top of the screen is a breadcrumb
path that identifies the resource you are currently browsing.

The breadcrumb path includes, from left to right, the category, type, and
name of the current resource. You can click either of the first two nodes in
this path to navigate back to a browse list of all resources of the same type
or category.

Click the Fuse HQ logo at the top left corner of any page to return to the
Dashboard.
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The Dashboard and Other Views

Dashboard The Dashboard (see Figure 1.1 on page 15), the Fuse HQ home page,
appears when you log in. Its purpose is to provide convenient access to the
information you are most interested in. Therefore, you have considerable
control of the content that appears on your Dashboard.

The Dashboard displays information in two columns, in frames called portlets
(see Dashboard Columns and Portlets).

Figure 3.2. Dashboard Columns and Portlets

Portlets

JANNN
\\[\Bssuumes T Analyze T Administration
i

Search Resources Y Auto-Discovery

Resource Name | | P\aﬁury{

Select a Dashboard

g resources to display

@ Favorite Resources

Resource
Resource Hame

No saved charts to display; to add charts to dashboard press "Save Chart to Tvpe
Dashboard” in the Tools Menu of metric chart view.

Availability Alerts

ko resources to display, please click the h'} icon above te add resources to portiet

Availability Summary Updated: 1:04 PM
@ Recent Alerts

Resource Type Availability

~ |:| Date / Time * Alert Name Resource Name Fixed Ack
No resources te display, please click theh‘i} icon above te add resources to portiet. n
No recent alerts to display
| e 4
Add content to this column:
Q@ Recent Control Actions
Dashboard Portlets summarizes the portlets that are available on the
Dashboard.
Table 3.1. Dashboard Portlets
Column Portlet Description
Left Search Resources |Lets you search for resources in the inventory by a string

occurring in the resource name and by resource category.

Saved Charts Lets you see a configurable slide show of graphical data for
selected resources.
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Column

Portlet

Description

Recently Added

Lists platforms added to the inventory during the preceding 48
hours.

Availability Summary

Indicates the current availability of a user-selected set of
resources. Entries in this list refer to resource types (for
example, ActiveMQ 5.x-fuse Queue Of Win32), with
resources of like type automatically grouped.

For each resource type you select, an icon indicates one of five
states: available (green), unavailable (red), partially available
(yellow), paused (orange), or no data collected (gray). The
number of resources of each type is also shown.

Summary Counts
(hidden by default)

Displays the total number of resources that the user has
permission to few, grouped by category and optionally
subtotaled by specific resource type.

Right

Auto-Discovery

Lists resources reported by Fuse HQ Agents but not yet added
to the inventory. You can select resources to add to or exclude
from the inventory.

Favorite Resources

A user-selected list of any set of resources in the inventory.

Recent Alerts

A list of alerts that match a user-specified set of criteria for
resources, severity, and time of occurrence. You can have
multiple Recent Alerts portlets on your Dashboard, each with
different criteria.

Control Actions

A list of actions performed via Fuse HQ on servers, services,
and compatible groups in the inventory during a user-specified
period ending with the present time. Each server or service
type defines the control actions that are available for it.

Problem Resources

A list of resources that have encountered out-of-bounds
conditions during a user-specified period ending with the
present time. The administrator defines the conditions that are
out of bounds by establishing baseline metrics for specific
resources.

Metric Viewer (hidden
by default)

A list of user-selected metrics for selected resources. You can
have multiple Metric Viewer portlets on your Dashboard, each
with different criteria.

Resources view

To go to the Resources view from the Dashboard (or from most other Fuse

HQ screens),
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Figure 3.3. Resources View
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the top. Then select Browse from the drop-down menu. (Alternatively, you
can select the self-explanatory options Currently Down or Recently Viewed.)

The Resources view provides comprehensive lists of resources in the inventory,
filtered by category and optionally by type. For example, Resources View
shows the Resources view filtered to show all servers.
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At the top of the shaded list area, the Resources view shows the current
inventory count for each resource category (Platforms, Servers, Services,
Compatible Groups/Clusters, Mixed Groups, Applications). Click any of these
categories to show the resources in that category. To further filter the results,
select a resource type from the drop-down list in the View field.

To view the list with graphical representations of the available metrics for
each resource, click Chart View. Switch back to the simple text list by clicking
List View.

To locate specific resources, enter all or part of the name in the Search field
and click the arrow button to the right. Note that performing a search filters
the lists for all resource categories. Therefore, for example, if you search for
a given string in the Services list and then switch to the Servers list, you might
see few or no entries. This is because the list of servers is filtered to show
only those results that match the search criteria. To remove the search filter
and show all items in the resource category, clear the Search field and click
the arrow button again.

Often you will want to proceed from the Resources view to see detailed
information about a specific resource. Clicking a button to the left of each
name takes you quickly to a specific tab on the resource page for that item:
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Administration view

The Dashboard and Other Views

M for the Monitor tab, | for the Inventory tab, or A for the Alerts tab. Clicking
the name itself takes you to the Monitor tab. See "Resource Pages"
on page 36 for more information.

The Resources view also lets you perform important inventory-management
tasks: defining groups and applications, and removing resources from the
inventory.

To group or delete resources, select them by clicking their check boxes at the
left. (To select or deselect all items in the current list, click the check box in
the list header row.) Then click the Group or Delete button. (Note that deleting
a resource removes it from the inventory, but has no effect on the resource
itself. If you decide to add a resource back to the inventory after deleting it,
you can perform a new auto-discovery on its host platform.)

To define applications, click Tools Menu at the top right and select New
Application. This menu also gives you another way to define groups, and an
option to manually add certain types of platforms.

To go to the Analyze view from the Dashboard (or from most other Fuse HQ
screens), hover the cursor over the Analyze tab on the black strip near the
top. Then select one of the three options on the drop-down menu: Reporting,
Alert Center, or Event Center.

The Reporting page lets you generate a variety of reports in various formats.
The Alerts Center and the Events Center show all alerts and events for the
entire system.

To go to the Administration view from the Dashboard (or from most other
Fuse HQ screens), click the Administration tab on the black strip near the
top.

This view provides links to various administrative tasks, notably management
of users and roles. Click any link on the page to perform the indicated task
or view data contributed by installed plug-ins.
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Resource Pages

Getting details on specific
resources

Monitor tab (Current Health
screen)

36

For every resource in the inventory, Fuse HQ presents detailed information

in a set of tabbed pages. The available tabs and their content depend on the
nature of the resource in question, but all basic resources (platforms, servers,
and services) and compatible groups have a Monitor tab, an Inventory tab,
and an Alert tab. Mixed groups and applications do not have all of these tabs.

Resources that allow control actions have a Control tab that provides access
to these actions. For example, the Control tab for a Fuse Message Broker
queue lets you send a text message to the queue.

Clicking any resource name almost anywhere in Fuse HQ takes you directly
to the Monitor tab for that resource. (There are a couple of exceptions: Clicking
a platform name in the Auto-Discovery portlet takes you to the Auto-Discovery
Results screen for that platform; and clicking the name of a mixed group,
which does not have a Monitor tab, takes you to the corresponding Inventory
tab.)

These pages are designed to help you navigate easily through the hierarchical
structure that includes the resource. In the top left corner of every page is a
Map button. Clicking this button reveals a tree diagram showing the current
resource along with the other resources associated with it. In general, "parents"
appear below and "children" appear above the current resource, as applicable.
For example, in the map tree for a server, the host platform (parent) appears
below the server, and hosted services (children) appear above. You can click
any resource in the tree to go to the resource pages for that item.

The Tools Menu at the top right of each page provides options appropriate
to the current resource type.

A prominent label at the top right identifies the resource category of the current
item: platform, server, service, group, or application.

The Monitor tab, also called the Current Health screen, provides the most
detailed information available about the performance and activity of a given
resource. The right column of this page offers both graphical and numerical
displays of metric data collected from the resource during a specified time
period. The left column, headed by a sub-tab labeled Resources, shows
resources related to the current one and provides controls for specifying which
metrics are charted in the graphical display.
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In the right column, to switch between the graphical and numerical displays,
click the Indicators and Metric Data sub-tabs. To see a full-size chart for any
individual metric, click the metric name on either tab.

On the Indicators sub-tab:

Column charts appear for each selected metric. The horizontal axis is a time
line that applies to all charts in the display. Click a circle in the row either
above or below the charts to highlight and display the precise time of a specific
point on the axis.

The colors of the circles in the top row indicate availability, as follows: green,
100 percent available; yellow, partially available; red, unavailable; orange,
paused; and gray, no data collected.

If log tracking is enabled for the resource, a blue square appears just above
the bottom row of circles for any time segment during which Fuse HQ has
recorded an event. Click the blue square to display the available log messages.

You can remove and rearrange the charts, and save any configuration as a
custom view that is specific to the current resource. To move a chart up or
down in the column, use the & and = buttons above the top right corner of
the chart; to remove the chart from the column, click the B button. To save
the current view, select Create New View in the Vi ield at the top right
corner of the display area, enter a name, and click

On the Metric Data sub-tab:

Metric values are shown in a tabular format. Various controls allow you to
specify the refresh rate, the data collection interval, and other settings. You
can select one or multiple metrics in the table and click Chart Selected Metrics
to display a full-size chart.

The Metric Data tab offers a convenient way to establish baselines, which
are useful for defining alerts and tracking trends, among other purposes. To
automatically set the baselines for one or more metrics to the LOW, PEAK,
and AVG values currently shown, select the metrics and click Set Baselines.

(® Note

Additional baseline-setting controls appear at the bottom of each
full-size chart (provided the chart shows only a single metric).

On the Resources tab:
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Inventory tab

Alert tab
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The related child and parent resources of the current resource are listed. To
the right of each related resource name is an availability indicator and a
with additional information (and, in some cases, active links) pertaining to
the resource.

The other options available on the Resources tab vary according to which tab
is selected in the right column. With the Indicators tab open, you can use
the available controls to add charts for metrics of these related resources to
the display in the right column. With the Metric Data tab open, you can filter
the metrics that appear in the table.

To add metrics for a related resource, select the Indicators tab on the right.
Then, in the left column, check the related resources for which you want to
see metrics, and click View Metrics. The metrics collected from the selected
resource appear in a list below. You can then add a chart for any of these
metrics to the Indicators tab by clicking the right arrow button to the right of
the metric. Remember that you have the option of saving any set of charts
on the Indicators tab as a view that you can recall whenever you are
monitoring the current resource.

To filter the display on the Metric Data tab, check the desired categories and
types, enter a search string if desired, and click the right arrow button to the
right of the Search field.

The Inventory tab includes a number of portlets containing different types of
information about the current resource and others that are related to it. The
exact set of portlets available depends on the type of the current resource.
Only one portlet is open at a time. To open a different portlet, click its title
bar.

Where appropriate, the portlets provide controls that let you edit the resource's
properties or change relationships with composite resources. For example,
you can add a resource to a group or remove a service from an application.

For the most part, working with the portlets and controls on the Inventory
tab is intuitive. It is worth mentioning here that when you want to enable
event tracking for a resource, you do so in the Configuration Properties portlet
on the resource's Inventory tab.

The Alert tab has two sub-tabs, Configure and Alerts.
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The Configure sub-tab lets you define the conditions that trigger an alert on
the current resource. These conditions can be based on any metric data or
logged event that the resource makes available to Fuse HQ. In addition to
defining the conditions, you can specify actions that Fuse HQ should perform
when the alert is triggered, such as sending e-mail notifications or executing
a script.

To keep the flow of notifications orderly and create an audit trail, you can
pair an alert with a corresponding recovery alert. The primary alert detects
the problem, initiates the specified response, and then disables itself to prevent
repeating the response with every data-collection cycle. The recovery alert
detects the return to normal conditions, executes its own response (typically,
sending notification that the resolution has occurred), and re-enables the
primary alert.

The Alerts sub-tab lists the alerts that have been triggered on the resource
and lets you acknowledge them or mark them as fixed.
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